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Introduction. Code Page notion.

The ParaWin system is common system for multilingual support for Windows 3.0 
and 3.1. What is it needed for? History of computer industry developed so, that now 
(and almost everybody knows it) we have just 255 symbols at a time to represent any
textual information. Obviously it is not enough. Then the system of code pages was 
invented. In Microsoft Windows CodePage has two senses. From one point of view - 
it the character set, containing some 255 characters. From the other side it is a set of 
components, needed for Windows to work with this Character Set. They are:
keyboard layout;
program that performs such language-specific operations as alphabetical sorting, 
upper/lower case convertions;
Fonts, which, in turn are subdivided onto system and user. System fonts are those, 
that must be presented always, and without which Windows will not work.
Translation tables, that are used to convert text from different DOS codepages into 
Windows CodePage when you do exchange files with DOS applications.

ParaWin is delivered bundled with all the neccessary files for Windows Code Pages 
management. Now ParaWin supports all Windows Roman languages and keyboards 
(i.e. English, German, Franch etc.) and in addition - Russian, Ukranian and 
Belorussian languages, and Russsian, Russian - phonetical (with sound liking 
placement of characters on keyboard), Belorussian, Ukranian, Serbian, Macedonian, 
Bulgarian keyboard layouts.
The ParaWin system allows you to switch all these components without dealing with 
system configuration files, and the files, representing these components themselves. 
You have not to know much about all these Code Pages, you just select the needed 
Windows language and go. 
There is no principal restrictions to use ParaWin with East European, Turkish or 
some other languages, only additional Code Page specific sets of files required.



Installing ParaWin.

To install ParaWin you first choose the "Run" command from "File" menu in 
Program Manager. Then you type in the dialog Box prompt, that would appear, the 
drive letter for your 3.5'' drive, followed by colon and "install". It should look like 
this:

b:install
If your system's 3.5'' drive is drive B. Then you either press Enter or click the "OK" 
button. The ParaWin install program starts up. It will paint a ParaWin Logo and 
display a dialog box. At this dialog box you need to choose:

first - an additional keyboard layout. The main keyboard layout is assumed the 
keyboard that you have been using in Windows before intalling ParaWin. After 
installation  main keyboard layout will not be changed.

second - if you are installing ParaWin on a network you will have to choose the 
installation type - either Server or Workstation, which depends on the machine, 
where from you have started the installation program. If you choose the server 
installation, you must have the right access rights for Windows shared system 
directory, because all ParaWin files are assumed to be copied into that directory. If 
you don't have such access rights the ParaWin will be installed in your private 
Windows directory.

After you complete selection, you click "OK" button or press Enter key. 

Next the dialog where you choose the key (or key combination), that will be used to 
switch between different keyboards, appears on the screen. Don't be afraid to make a 
wrong choice - you will be able to change that key any time after installation without
any problem. 

Now the install program starts copying ParaWin files. It does not copies all the files, 
but only those, that are necessary. It also copies the ParaWin system programs.
When the copying process will be completed you will have to restart you Windows, 
since you system setting have been changed, and that changes will not take effect 
until you restart Windows.



The ParaWin system.

The ParaWin install program will create for you a new group in Program Manager. It 
will have name "ParaWin" and contains five programs.

Keyboard Indicator.
The Keyboard Indicator appears on Your screen each time while you running your 
Windows with ParaWin. You can use its menu to switch between different layouts 
instead of using 'hot' keys. ALT-F4 will close that window. The Keyboard Indicator is
a useful program, that displays the current working keyboard layout and lets you 
easily switch between keyboards with mouse. This program is just a single combo 
box, which is "always-on-top", and contains a list of installed keyboards. This 
program also produces a musical beep, when you switch the keyboards. the ParaWin 
install program changes the settings in win.ini file so, that the Keyboard Indicator 
will always rub at the start up of Windows. You can move the Keyboard Indicator's 
window by dragging it with mouse. It will remember its position and at next run will 
be displayed exactly on that same place at your display.

Keys Map: Keyboard Font viewer. 
First is Keyboard Font viewer. It is designed to help you obtain information about 
current keyboard layout. When you start this program a small windows, representing 
your keyboard will be displayed. You can see what character is mapped to each key 
or key combinations like CTRL+ key.  You can change the appearance of that 
window by setting the monochrome mode from "View" menu of this program. For 
more flexibility you can also change font, in which characters are displayed, to match
character set used in the keyboard.  

Keyboards Manager.
The Keyboards Manager is more complicated program. It allows you to add or 
remove keyboards into/from your system. This program displays a dialog box with 
two list boxes and a set of command buttons. In the left list box, there is a list of 
keyboards, available for you to install. The right list box represents the already 
installed keyboards. 
To install a keyboard in your system, you have to choose it in left list box, then click 
button "Install". If that keyboard will not be found on your hard disk in your 
Windows or Windows system directory, you will be prompted to supply a distributive
disk of either Microsoft Windows or ParaWin (it depends on the keyboard being 
selected). In case of   the keyboard file reside on your hard disk you will be prompted
to use this file or a new one from dictributive disk.  Be careful with this option, and 
don't replace any file(s), if you are not sure that you have the appropriate distributive 
disk. In fact, you should replace file only if you are sure that this is an obsolete 
version, that was left by some other program, for example older version of ParaWin. 
You can also change the order in which the keyboards appear in Keyboard Indicator .
To do it, select in right list box the keyboard you want to move at the other position, 
then click button "Change Order". The cursor form will be changed onto pointing 
hand. Then you just point onto the place, where you want to put the selected 
keyboard and click there. But, the "USA (default)" keyboard can be placed only at 
the first position. There is a special keyboard, called "custom", this is an editable 
layout. When you install it, you can edit this layout with  Keyboard Editor (see later).



You can run it just from Keyboards Manager. You simply need to select the 
"Custom" keyboard layout, after it have been installed, and click the button "Edit...". 
The Keyboard Editor  will be invoked.
To remove any installed keyboard you select the layout and click "Remove" button. 
After you complete installing keyboards click the "Exit" button to leave Keyboards 
Manager.
With Keyboards Manager you can also easily change the key, that switches 
keyboards. You simply click the "Set switch" button, and you'll get a dialog with list 
of all available key switches. You make your selection, and then click "OK" button.

CodePages Manager.
Next comes CodePages Manager. This is a very important tool for people, who 
frequently change the language with which they work. The CodePages Manager 
allows you to easy switch entire Windows system into other language. It will 
automatically copy the necessary fonts. It also will try automatically select your DOS
Settings. This program displays a dialog box, too. In this dialog you select the four 
main settings: a Windows language, a keyboard (and, probably a second keyboard, if 
it is needed), a DOS Character Set and a text translation table. First, and major is 
Windows language. When you change this setting almost all the other settings are 
changed appropriately. This setting determines which fonts will be copied, it also 
affect such things as alphabetical sorting in Windows programs and Upper/Lower 
case conversions. The keyboard setting is just a keyboard layout you will use. If  a 
non-Roman (based on a non--Roman alphabet) keyboard selected,  a second 
keyboard list appears on the screen in the same dialog. The second keyboard is 
needed  to be able to enter filenames. The DOS Character Set setting determines the 
fonts used by Windows, when windowed non-Windows applications are displayed. 
And a translation tables is table, used when you do import or export files created in 
DOS applications. In the CodePages Manager's dialog box there are also four check 
boxes, which let you control some options. 
First is the "Copy Fonts" check box. Usually, this option should be turned on. But, if 
you want the ParaWin not to copy fonts you can turn off this option. This case may 
occur, for instance, if you have localized version of Windows, and you didn't 
purchase the appropriate fonts for your character set.
The "Auto switch" check box is used to control the process of making selection more
simple. When this option is on, the CodePages Manager tries to select automatically 
your DOS settings, relying upon the language, you've selected. 
The "Show All" check box affects only the DOS related settings - DOS Character set 
and text translation table. When this option is on, you can select them from the full 
set of all available, but not from only those, which match you language selection. 
Such a choice, when you select a DOS settings different from you Windows ones, 
may be dangerous, but is needed, when you work with different languages in DOS 
and Windows. After you complete the configuring process click the "OK" button to 
write your changes to hard disk. If  some files not found in your system, a dialog box
will be displayed, prompting you to supply the distributive disk, with the necessary 
files. In this dialog box you will be able to see the disk name and a file, which is 
needed. If click then "Skip File" button the file will not be copied, and this setting 
will not be changed.
You'll have to restart Windows, if the CodePages Manager will have to change your 
Windows CodePage, or some  system fonts. The appropriate dialog box will be 
displayed. If you have active non-Windows applications, a warning occurs in that 



dialog box and you'll have to close that application and then restart.

Keyboard Editor.
The Keyboard Editor is a program, that allows you to create and edit your own 
keyboard layouts. 

First you have to install "Custom" keyboard with help of  Keyboards Manager, to get
access to Keyboard Editor.  
When you edit a keyboard layout and  saved it in a file, you have to attach it to 
custom keyboard to activate it.  To do it, you just choose the "Attach to custom 
keyboard" option from "File" menu in Keyboard Editor. If your keyboard was not 
saved, you will be prompted to save it. 
When the Keyboard Editor starts up, it usually loads the keyboard layout currently 
attached to custom keyboard. But if no layout is attached the currently working 
keyboard will be loaded. To create a custom layout, based on some specific 
keyboard, you need to use the "Load active layout" option from "File" menu in 
Keyboard Editor. For example if you want to create your custom layout, based on 
French keyboard, you first install the custom keyboard, and a French keyboard. Then
you start Keyboard Editor. Then you make your French keyboard active (with 
Keyboard Indicator, for example). And then you load it in Keyboard Editor just was 
described before. You can edit it now, and after completing, attach it to custom 
keyboard. In keyboard indicator the custom keyboard is shown like "Key Table 
Custom". To edit your keyboard you make the simplest things.  Click, or press on 
keyboard, the button, or the button combination (such as CTRL+ALT+key) you want
to edit. Then click or manually select, using arrow keys, the character you want to 
place onto that key. You can edit five keyboard states: SHIFT+..., CTRL+..., 
CTRL+ALT+..., SHIFT+STRL+ALT+... and clear (unshifted) state. You can also 
select which keys will be capitalized - converted to upper case, when the CAPS 
indicator is on. (Very useful option, but we simply can't describe it properly.) To do 
so press CAPS. The window, containing character map will disappear, and instead of 
it you'll get a check box with "Capitalized" name. To make key capitalized press it, 
then if that check box will be "checked"  the key will be capitalized, otherwise - not. 
To return to editing you just press CAPS key again. You can also select font in which
the Keyboard Editor will be displayed. Use the "Fonts" item from "View" menu for 
that.

Two programs, Keyboards Manager and CodePages Manager have an aditional help  
feature. It is a line of text at the bottom of each dialog, determining what to do with 
that or another control in a dialog, and what that setting means. The text in this help 
line is determined by the position of mouse cursor. The help is displayed for that 
control in dialog, above which the cursor is.

Also if CodePages Manager or Keyboards Manager will find, that you have a non-
ParaWin keyboard driver, you will get a dialog prompting you to reinstall it in your 
system.

Win.ini and System.ini changes made by ParaWin and troubleshooting.

The win.ini and system.ini files are commonly referred to as configuration files, and 
contain settings, describing your system for Windows. ParaWin changes some of this



settings and, if an unexpected error occurs, you always can fix it by manually 
restoring the settings in this files.
They should be listed as follows:

system.ini:

section [boot],
fonts.fon - this is a system font used by your system and must always be present.
fixedfon.fon - this is a system font with fixed character spacing, used in older 
versions of Windows.
oemfonts.fon - this is a font, used to displayed a windowed non-Windows 
applications in 386Enhanced mode.
keyboard.drv - this is a keyboard driver, used in your system. Fir ParaWin to work 
properly it should always be worldkbd.drv
language.dll - this is a program, that performs sorting operations and lower/upper 
conversions.
section [keyboard]
keyboard.dl? - these are keyboard files that describe keyboard layouts. The custom 
keyboard filename is kbdedit.dll.
oemansi.bin - this is translation table. It is used when you import or export text 
from/to DOS applications.
keyswap - here is described the key combination, switching the keyboards. you 
should not change it manually. Use Keyboards Manager.
keybedit.bin - here is filename for the file in which is stored your currently attached 
to custom keyboard layout.
section [386enh] 
EGA40WOA
EGA80WOA
CGA40WOA
EGA40WOA 
woafont.fon (for version 3.1)
- these are fonts, used to display a windowed non-windows applications.

win.ini file
section [fonts]
In this section the fonts installed in your system are described. If the option "Copy 
Fonts" in CodePages Manager is on, all the standard fonts (standard, that are fonts, 
usually bundled with Windows) will be changed. Otherwise, in this section will be 
written only those fonts, that are not already in system. No currently presented fonts 
will be changed.


